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INTRODUCTION 

 

This manual provides the operation and maintenance instructions for the Isoprime GC5. This will 

include details on the Isoprime mass spectrometer with the GC and GC5 interface. We have 

endeavoured to include all operational aspects within this manual, however if you feel more 

information is required or that you can add some more details, then please contact the Customer 

Service Department at Isoprime Ltd or your local Isoprime representative. 
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WARRANTY 

 

The information contained within this document is subject to change without notice. 

Isoprime Ltd. makes no warranty of any kind with regard to this material, including, but not limited 

to, the implied warranties of merchantability and fitness for a particular purpose. 

Isoprime Ltd. shall not be liable for errors contained herein or for incidental damages in connection 

with the furnishing, performance, or use of this material. 
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SAFETY INFORMATION 

 

The Isoprime mass spectrometer meets the following IEC classifications. 

Safety  Class 1 

Transient Overvoltage  Category II 
Pollution  Degree 2 

 

This unit has been designed and tested in accordance with recognised safety standards and designed 
for use indoors.  If the instrument is used in a manner not specified by the manufacturer, the 
protection provided by the instrument may be impaired. Whenever the safety protection of the 
Isoprime has been compromised, disconnect the instrument from all power sources and secure the 
unit against unintended operation. 

Suitably qualified personnel only should perform maintenance procedures. Substituting parts or 

performing any unauthorised modification to the instrument may result in a safety hazard. 

Disconnect the mains supply before removing covers. You must comply with all local and national 

requirements for electrical and mechanical safety. 

Please contact the Customer Service Department at: 

Isoprime Ltd 

Isoprime House 

Earl Road 

Cheadle Hulme 

SK8 6PT 

UK 

service@isoprime.co.uk 

 

or your local Isoprime representative should you require any further information. 

  

mailto:service@isoprime.co.uk
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SAFETY SYMBOLS  

 

Warnings in the manual or on the instrument must be observed during all phases of service, repair, 

installation and operation of this instrument. Failure to comply with these precautions violates the 

safety standards of design and the intended use of the instrument. 

Isoprime Ltd. assumes no liability for the customer’s failure to comply with these requirements. 

The following safety notices and symbols are used in the manual or on the instrument. 

WARNING 

 

Warnings are given to highlight situations or conditions where failure to observe the instruction 

could result in injury or death to persons. 

CAUTION 

 

Cautions are given to highlight situations or conditions where failure to observe the instruction could 

result in damage to the equipment, associated equipment or process. 

 This symbol indicates that there are accompanying instructions which should be referred to          

for more information. 

 This symbol indicates where hazardous voltages may be present.  

 

 This symbol indicates a hot surface. 

 

 This symbol indicates a risk of corrosion. 
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SITE REQUIREMENTS 

BENCH SPACE  

 

Must be of a construction adequate to support the weight of the instrument and associated systems, 

should be heat resistant and should also be free of any vibration or movement which may impair the 

performance of the instrument. 

ROOM TEMPERATURE 

 

The maximum operational room temperature should not exceed 25°C (ideally 22°C). Large 

temperature fluctuations caused by sunlight or drafts (including air conditioning units) have to be 

avoided during measurement, and should not exceed 1°C/ hour.  

HUMIDITY  

 

Relative humidity should not exceed 60% at any temperature.  
 

CORROSIVE AND HARMFUL ATMOSPHERE  

 

Instrument must be located in a clean air, pollution free environment.  
 

DUST FREE ENVIRONMENT  

 

High dust levels increase the probability of computer disc drive failures. Dust particles will also block 
air filters and fans on the instrument which may cause overheating.  
 

EXHAUST FUMES  

 

The vent ports of the individual systems should be connected to a fume extraction system.  

CAUTION: If SO2 or CO is used in your chosen system, an efficient fume extraction hood is needed so 

that concentrations in laboratory air comply with the local health and safety standards.  

COMPRESSED AIRLINE  

 

A water and oil mist filter should be fitted to the supply line and contain at least a 0.5μm particulate 

filter. Addition of a 0.3μm mist filter is recommended to minimise the amount of oil transferred to 

the instrument.  

GAS REGULATORS  

 
Clean, two stage regulators with stainless steel diaphragms must be fitted on the gas supplies. The 

second stage regulator must be capable of delivering pressures up to 6 Bar (90 psi). 
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GAS LINES  

 

Clean, chromatography grade 1/8” stainless steel gas lines are needed to connect the system to the 

gas cylinders. 

Note: Specialised gases for use with the instruments are not provided.  

Note: Chromatography grade pipework is not provided.  

ELECTRICAL POWER REQUIREMENTS  

 

The system may require one or more connections to the mains supply. Some electrical systems have 

circuits which are susceptible to large voltage transients. These should be protected by a suitable 

transient suppressor if the local supply is of poor quality. Some sites may also wish to protect some 

(the pumping circuits, for example) or all circuits from power failure with an un-interruptible power 

supply unit. Voltages quoted should be adhered to, e.g. when 230V is used, this voltage can be 

anywhere between 230V and 250V, 208V is not acceptable. For sites where the voltage does not 

comply with the quoted specifications, a suitable transformer will be required.  
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SYSTEM INFORMATION 

SYSTEM TYPE 

 

GC Pyrolysis/Combustion interface with 7890A GC 

PLACEMENT 

 

This is a bench top instrument 
 
Provide at least 250mm clearance around the system for maintenance access.  

GAS CONNECTIONS 

 

For the connection of the gases, a supply of 1/8” GC-Grade stainless steel tubes needs to be 
available, to be supplied by the customer. 1/8” Swagelok connections should be used on the cylinder 
and on the system where relevant. 

DIMENSIONS 

 

 GC5 Interface Agilent 7890A GC Agilent 7693 Sampler 

Height 540mm 590mm 450mm 
Width 520mm 540mm 20mm 
Depth 400mm 500mm 500mm 

Weight 80kg 50kg 6kg 
 

ELECTRICAL POWER 

 

 GC5 Interface Agilent 7890A GC 

Voltage 230v 120V – 240V 

Phase 50 - 60Hz 48 – 66Hz 

Max Current 9A 18.8 – 9.4A 

Max. Fuse Rating 16A 20A 

Transformer 
Rating 

2.1kVA 2.3kVA 

Transient 
Sensitive 

No No 

Connection Type 10A IEC320/C13 16A IEC320/C13 
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CONNECTIONS NUMBER OF ELECTRICAL SOCKETS REQUIRED 

 

Max. 4  

All connections to the mains supply should have a terminal (the neutral) which must be at earth 
(ground) potential. Cables will be delivered with a standard 3 pin UK plug and/or and IEC power 
block. Alternative cables or plug adaptors may be required. 

HEAT DISSIPATION 

 
 

GC5 Interface Agilent 7890A GC 

300W 2250W 

 

COMPRESSED AIRLINES 

 

The GC5 Interface requires a supply of 60 psi / 4 Bar.  

The GC5 Interface is equipped with a 6mm push-fit connector  

 

SPECIALISED GASSES 

 

 Purity grade H2O Content 

Helium 99.999% < 1 vpm 
Synthetic air* Zero Grade 2 vpm 
Hydrogen*# 99.999% < 2 vpm 

Oxygen 99.998% 1 vpm 
 

* Required for the operation of the FID Detector.  

# Required for Oxygen Analysis 

LIQUID NITROGEN 

 

The system requires liquid nitrogen for nitrogen analysis. If the Agilent 7890A GC is equipped with a 

cryogenic cooled PTV injector, either liquid nitrogen (1/4” insulated copper tube) or liquid carbon 

dioxide (1/8” heavy walled, stainless tubing) is needed. 

  



 

   Isoprime IRMS-GC-GC5 

Version : 1.13 Page 12 

TECHNICAL SPECIFICATIONS 

All GC installation and service work is tested using Universal mix that comprises of four compounds; 

two Alkanes, a Methyl Ester and Nicotine and it is this mix that is referred to in this manual. 

EXTERNAL PRECISION 13C (CO2) 

0.2‰ (SD 1 ; on each component over 5 injections of Universal mix) 

EXTERNAL PRECISION 15N (N2) 

0.5‰ (SD 1 ; on a single component over 5 injections of Universal mix) 

EXTERNAL PRECISION D (H2) 

3.0‰ (SD 1 ; on each component over 5 injections of Universal mix) 

EXTERNAL PRECISION 18O (CO) 

0.8‰ (SD 1 ; on a single component over 5 injections of Universal mix) 
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GC5 COMBUSTION/PYROLYSIS INTERFACE SYSTEM 

OVERVIEW 

 

Right hand GC with autosampler 

The Isotope Ratio Mass spectrometer (IRMS) GC-GC5 Interface System is designed to determine the 

composition of individual compounds in complex organic mixtures.  

The sample is injected into the GC where it is vaporised and then separated using a capillary gas 

column. The sample travels through the column in a stream of inert carrier gas, in this case helium, 

where, depending on the properties of each component, it is separated. The time it takes for the 

sample to elute is known as the retention time. The retention time and quality of separation is 

determined by a number of factors, such as column and sample properties and oven temperatures. 

The user can select the separated portions of the sample to be analysed and the chosen portion can 

then be sent to the GC5. Using copper oxide (CuO) for carbon/nitrogen, the sample is 

oxidised/reduced, allowing for isotopic analysis in the IRMS.  

The complete GC-GC5 Interface consists of the following parts: 

1. An Agilent 7890A GC modified for IRMS coupling 

2. The combustion/pyrolysis GC5 Interface, including regeneration possibilities for the 

combustion/pyrolysis tubes 

3. Water traps for the protection of the IRMS 

4. An optional standby valve and/or autosampler  



 

   Isoprime IRMS-GC-GC5 

Version : 1.13 Page 14 

THE GC5 INTERFACE 

 
GC5 has 4 main components: 

1. Gas Distribution 

2. Electrical System 

3. GC5 Combustion / Pyrolysis Interface 

4. Open Split 

 

GAS DISTRIBUTION 

 
The following gases are required for the full operation of the interface: 

 Helium (He) - carrier gas for the GC and the furnace 

 Hydrogen (H2) - for oxygen analysis 

 Oxygen (O2) - for the regeneration of the furnace tube 

 Compressed Air - for valve operation 

 Clean Air  - for operation of the FID 

The gas distribution network for both the standard carbon/nitrogen/hydrogen and additional oxygen 
option is positioned in the top section of the GC interface cabinet and is depicted below. 

The compartment is accessed by removing the top panel of the interface cabinet. The gases are 

introduced to the rear of the cabinet.  

On the front of the cabinet are two 15 psi pressure regulators, one for the FID helium supply and the 

second for the sample line helium. Between the regulators is a manual switching valve for selecting 

sample line helium to the right (for GC carbon/nitrogen/hydrogen analysis) or left (oxygen analysis). 

The FID helium supply runs from the He input, at the back of the GC5 through the FID He regulator 

and into the GC cabinet. In the GC cabinet the tubing connects to one side of the T section of the 

SGE MOVPT 1/100 Heart Split valve. 

The sample line helium flows from the He input to the sample line regulator. During instrument 

operation, helium flows from the exit of the regulator, into the GC cabinet and connects to the zero 

volume T-piece on the end of the furnace tube. The helium flows along the length of the furnace 

tube and is either taken into the capillaries running to the IRMS or vented to atmosphere at the 

open split “pigtail” assembly fixed to the end of the furnace tube. 
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Standard gas line network 

 

With additional oxygen option 
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THE ELECTRICAL SYSTEM 

The electrical system consists of two heaters: one for the heated interface and one for the furnace. 

These can be individually enabled via switches beside the units. 

COMBUSTION INTERFACE 

The combustion interface consists of two different elements: 

1. An interface heater running between the GC oven and the furnace assembly 

2. Combustion assembly consisting of a furnace assembly and a furnace tube running 

through the middle of the interface heater and furnace assembly. 

INTERFACE HEATER 

The heated interface ensures that sample eluting from the column is transported to the combustion 

furnace with no risk of condensation.  

The temperature of the heater must be sufficiently high to avoid condensation of the sample as it 

passes from the GC to the GC5 furnace assembly.  

Cold spots on the interface must be avoided. Thus the interface assembly must be properly engaged 

within the wall of the GC cabinet and in the insulation disk at the end of the furnace assembly. This 

will ensure minimum disruption of the temperature profile between the GC cabinet and the 

interface heater and the furnace assembly.  
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COMBUSTION ASSEMBLY 

The Combustion Assembly consists of a modified Carbolite MTF12/10 furnace controlled by a 

CAL3300 control unit situated on the front of the GC5 unit.  

The Furnace Tube is the site of combustion or pyrolysis, converting the sample compounds to the 

analyte gas for analysis. The furnace tube runs through the centre of the interface heater and 

furnace assembly. The geometry of the tube filling is designed to ensure that the packing lies within 

the hottest section of the furnace assembly.  

It is important that the isotopic composition of the sample gas accurately reflects that of the original 

starting compound. Combustion/pyrolysis should therefore be complete. It is important that the 

tube filling (reactants or catalysts) is at a sufficiently high temperature to achieve full 

combustion/pyrolysis, nor should there be any cold spots in the combustion interface or sites of 

contamination, in which the sample compounds can condense.  

THE OPEN SPLIT 

The open split “pigtail” assembly is designed to protect the ion source from pressure fluctuations 

arising from the processes occurring within the GC or GC5. At the open split the pressure is 

maintained by the ambient atmospheric pressure. The open split marks the change from a high 

pressure system in the GC and combustion interface, to a low pressure system dominated by the 

IRMS vacuum system and extending to the water trap facility and the connecting capillaries.  

Sample line helium flows from the Zero Dead-Volume T-Piece at the GC end of the furnace tube 

towards the open split. At the open split the fused silica capillary connected to the water trap and 

ultimately the IRMS draws up helium using the IRMS vacuum system. Excess helium is vented to 

atmosphere through the stainless steel capillary on the open split “pigtail” union. 

The sample line helium pressure is set to prevent ingress of atmospheric gas at the open split 

assembly. Operating the system at a high sample line helium pressure results in dilution of the 

sample, reducing the sensitivity and too low a sample line helium pressure will result in 

“breakthrough” of the solvent into the GC5 and IRMS (see page 37 for further information) 
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THE WATER TRAPPING SYSTEMS 

The water trapping facilities available on the GC interface are designed to remove water generated 

in the furnace tube during the combustion of the organic molecules. Two types of water trapping 

facility are available. The water traps are positioned after the open split assembly of the combustion 

interface. 

NAFION MEMBRANE 

During combustion, water can form in the sample. It can be removed by passing the sample through 

a nafion membrane. The polymer in the nafion membrane is strongly hydrophilic, meaning that it 

strongly attracts moisture. 

Water from the sample gas is absorbed on the inner surface of the membrane and passes towards 

the outer surface where it is then removed by a dry flow of helium passing over the outside of the 

nafion membrane. 

CRYOGENIC TRAP FOR NITROGEN MEASUREMENTS 

The second water trapping facility is a cryogenic trap or “cold” trap, which freezes both H2O and CO 

(arising from CO2) to allow for accurate N2 measurements 

The Dewar used when measuring nitrogen consists of an insulated container or “trap” filled with 

liquid nitrogen (temperature of –196°C) into which a loop of 320um deactivated silica capillary is 

suspended. The system has no electronic temperature control and relies entirely on the liquid 

nitrogen temperature to capture both the H2O and CO2.  

 

Nitrogen Cold Trap - Typical usage of liquid nitrogen is approximately 5 litres per day. 
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THE GAS CHROMATOGRAPH - AGILENT 7890 

An Agilent 7890A Gas Chromatograph User Manual is either supplied with the instrument or 

available to download online. 

THE GAS CHROMATOGRAPH CABINET 

The GC in its standard configuration consists of a standard GC oven fitted with a Split/Splitless 

injector system and a Flame Ionisation Detector (FID). The GC has been modified in order to 

accommodate a number of components necessary to interface it with the IRMS. It can still 

nevertheless be used as a stand-alone unit. 

In the GC cabinet, a system of capillaries and valves enables diversion of the sample either to the FID 

or to the combustion interface. The arrangement of capillaries within the GC cabinet is shown in the 

figure below. 

 

THE HEART SPLIT MECHANISM 

A schematic of the GC oven arrangement is shown below. 

 

 Injector 

250 m 

250 m  
 

C B 

B E 

B 

Sample Helium 

In 

F 

C 

A 

320 m 

 FID Helium IN 

FID 

D 
D 

Column 

VSOS 

Heart Split Valve 

 

Heart Split Mechanism. Letters indicate Ferrule type (See table below) 
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Location Ferrule Type Info 

A GVF 16-003/004 Vespel Backdrilled 

B GVF 16-005 Vespel 

C GVF 16-16 Vespel Sealing Ring 

D GFF 16-005 Graphite 

E GVF 16 (2) 004 Vespel Two Hole 

F GVF 16 4-4 Vespel 

 

The Heart Split mechanism operates via a combination of a mechanical input (Heart Split valve) and 
a back flow of pressure.  

Helium enters the GC column at the injection port and travels through the column. Additionally, 
helium enters the furnace tube at the VSOS via the sample line helium input and also into the Heart 
Split valve via the FID helium input.  

When the Heart Split valve is open, sample flow is prevented from passing towards the furnace tube 

by the pressure of the sample line helium. The flow therefore passes towards the Heart Split valve 

and hence to the FID. 

When the Heart Split valve is closed, the flow is mechanically prevented from passing into the Heart 

Split valve. The pressure in the VSOS increases to a point where it is greater than the sample line 

helium pressure. The flow now passes into the furnace tube.  

The Heart Split mechanism has three purposes: 

1) It enables the solvent to be diverted away from the combustion furnace and the 

IRMS and vented to atmosphere. It is very unwise to allow the solvent peak to pass 

through the combustion furnace. Firstly, it depletes the furnace of oxygen and 

secondly, due to the usually large quantity of solvent injected, in particular when 

the GC is operated in splitless or on-column modes, incomplete combustion may 

result in contamination of the ion source. 

2) It enables the selection of isolated peaks or groups of peaks to be ‘Heart Cut’ from 

a complex chromatogram so that they can be selectively diverted to the IRMS, 

whilst the unwanted species are vented to atmosphere via the FID. 

3) It enables the introduction of pulses of reference gas on a clean background, whilst 

the effluent from the column is diverted away from the IRMS. When the Heart Split 

valve is in the open position, reference gas pulses can be introduced to the IRMS 

without fear of co-elution of the reference pulses and peaks from the sample 

preparation system. 

 

CONNECTING THE GC 
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GAS CONNECTIONS 

The GC requires a hydrogen and compressed air gas supply for FID operation. Helium carrier gas and 

compressed air supply comes from the GC5 (via “air to HS” blue output connection) 

INSTALLING THE FURNACE TUBES 

Before installing the GC oven components the furnace elements have to be installed. Carbon / 

nitrogen analysis uses a standard quartz tube filled with copper oxide, hydrogen uses a quartz tube 

filled with chromium and oxygen uses an inner nickel tube enclosed in a ceramic outer tube. 

CARBON/NITROGEN ANALYSIS TUBE SET-UP 

 

The furnace tube for carbon and nitrogen analysis consists of a long quartz glass tube filled with 

copper Oxide pellets which provides oxygen for the combustion process.   

Note: Fingerprints on the tubes should be avoided so gloves should be worn at all times when 

handling the tube. 

The tube slides in from the GC5 end and must be kept as straight and level as possible when 

inserting to avoid damage to the tube. One side of the tube has a silver wool packing that holds the 

copper oxide in place. Be sure not to hold the tube the wrong way round as the packing can fall out 

of the non-packed end. The end with the silver wool sits at the GC5 end and the open end towards 

the Agilent GC. 

 

 

 

 

 

 

 

 

 

Before sliding into the furnace carefully attach this fitting onto the end of the tube as shown below. 

Copper Oxide filling Silver Wool 

Quartz furnace tube 
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This fitting consists of an extended 1/8” nut, T-piece, ¼ nut and graphite 4-4 ferrule and a “pigtail” 

helium vent connection. 

The 30cm 0.006” Stainless Steel (SS) “pigtail” vent that is fitted which should have a flow of 

approximately 1-5ml/min. This flow is affected by the sample line helium pressure. 

Once this fitting has been attached securely to the tube it can now be slid into the GC5 furnace oven. 

The tube should slide easily through the assembly and emerge inside the GC oven.  

Now a Zero Dead Volume T-piece assembly can be fitted to the other end of the tube. Firstly, if not 

already connected, attach the T-piece assembly to the sample line helium tube coming out from the 

side wall of the GC.  

Using a GVF 4-4 Vespel ferrule, tighten the fitting to the furnace tube by hand. Now pull the tube 

back out of the fitting by approximately 5 mm. It is important that the glass tube does not bottom 

out in the fitting because it will be crushed once further tightening with spanners is required.  

Once finger tight, tighten the assembly using two spanners making sure not to put any strains or 

stresses on the glass tube. The recommended technique is to use just one hand to tighten the nut 

while keeping the assembly fixed. Holding the assembly fixed with one spanner parallel to the floor, 

position the other spanner on the nut at approximately 60 degrees or less pointing upwards. Slowly 

pinch the spanners together until the spanner that is positioned on the nut reaches the spanner that 

being held fixed. This slowly and carefully tightens the nut without putting any additional strain on 

the tube and gives much more control in tightening the connection and will drastically reduce cracks 

and breakages of the tube. 

 

 

 

 

 

 

“Pig-tail” 

Extended Nut 

T-Piece 
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Using approximately 50cm of 250 m ID fused silica, remove about 10 - 15cm of the outer polymide 

coating fusing a flame (e.g. a cigarette lighter.) This is done so the coating of the silica isn’t burnt 

inside the tube. Using acetone or similar and a cloth, wipe away the burnt silica. The thin inner 

coating that remains will be inserted into the furnace (from inside the GC oven). It is very brittle, so 

handle with care.  

Common practice is to initially screw the extended nut (and ferrule) with the silica onto the T-piece 

connector until finger tight. This helps to keep the silica centred in the fitting and makes it easier to 

feed the silica into the hole of the furnace tube. Once the silica is in the hole, slide it all the way in 

until it sits just before the Copper Oxide packing. Tighten up the connection further to secure the 

silica in place. 

  

Sample Line Helium In 

Stripped Silica 

Zero Dead Volume T-Piece 
Copper Oxide filling 
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COLUMN SET UP 

HEART SPLIT VALVE 

Connect approximately 25cm 320 m silica from the side connection of the Heart Split valve using a 

GVF 16-005 ferrule. Insert approximately 3cm of the other end of the silica into the FID using a 

graphite GFF 16-005 ferrule.  

The ferrule needed for the Heart Split valve connection is a “backdrilled” GVF 16-003/004 ferrule 

(the hole is a different size at each end). The silica should only fit halfway through the ferrule. This is 

so that the Heart Split needle doesn’t make contact with the silica and damage it. If it passes all the 

way through, silica with a larger outer diameter (OD) is required. 

 

Cut approximately 30cm of 250 m silica and insert one end into the bottom connection of the Heart 

Split valve and tighten the connection. Leave the other end of the silica free for now. 

GC COLUMN 

The GC comes with a 30m HP5 column of a 320 m I.D. with a film thickness of 25 m as standard. 

Users are requested to provide their own columns for their own applications. Hang the column in 

place on the supplied rack.  

  

Heart Split Needle 

GVF 16-003/004 Ferrule 

250µm Silica 
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SAMPLE INJECTION PORT 

Install one end of the column to the injector using a graphite GFF 16-005 ferrule. The silica should 

intrude no greater than 5mm into the injector. Be careful not to over tighten this connection as the 

graphite ferrule will easily compress and push graphite into the liner of the injector and block it. 

 

    The Split/Splitless Injector 

The injector can be used in one of two modes; split or splitless. The injector contains a heated 

chamber containing a glass liner into which the sample is injected through the septum. In split mode 

the sample vaporises to form a mixture of carrier gas, vaporised solvent and sample. A proportion of 

this mixture passes onto the column, but most is diverted through the split outlet. The split 

proportion or ratio can be programmed by the user on the GC.  

VSOS 

The VSOS is a zero volume connector that is used to split the Column flow, diverting the sample to 

either the FID or furnace tube. 

The VSOS is connected as shown below: 

 

 

 

 

 

Column 

Silica from Heart Split 

Silica from Furnace 
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When fitting the silica lines to VSOS, note that the two pieces in the GVF 16(2)-004 ferrule (the silica 

from the bottom of the Heart Split and the silica from the furnace) must sit at their very furthest,  

flush to the bottom of the ferrule. Ideally they should sit just inside the ferrule.  

If they protrude too far through the ferrule, tightening the nut will break or crush the silica and block 

the union. If they do not protrude enough, tightening the ferrule may close the ferrule beyond the 

silica and cut off the flow 

When tightening the VSOS connection it is recommended to make the end with the two pieces of 

silica first, holding the nut fixed and rotating the VSOS union to tighten it onto the nut. This way the 

silica won’t twist together and possibly break. 

When connecting the column to the VSOS, make sure that the silica does not protrude beyond the 

ferrule on the other side as a blockage might occur. 

NAFION MEMBRANE SYSTEM 

The Helium flow through the membrane assembly is set at 20ml/min using the Water Trap Purge 

needle valve connected to the side of the GC5 interface. 

A schematic of the nafion membrane system is shown below: 

 

 

 

The nafion membrane assembly comprises a length of GVF tubing enclosed within an outer sheath of 

glass or acrylic tubing. The ends of the nafion tube are fixed, and the glass or acrylic outer sealed by 

a pair of SGE SSUT 4/16/16 unions. The fused silica connections to the furnace tube (variable length 

of 220 m ID), and to the standby valve (length of 100 m ID) are also fixed by the SSUT union.  

The 220 m piece of silica is connected to the furnace tube protruding from the GC5. This is required 

to be inserted no more than 15cm into the tube. The 100 m piece of silica is connected to the IRMS 

inlet. Be sure to isolate the IRMS and turn off the source before making changes to the inlet. 

Set the 3-way whitey valve on the front of the GC5 so that the sample line Helium flow is correct for 

the required analysis. Carbon/nitrogen /hydrogen are towards the right, oxygen towards the left.  

Sample line Helium pressure is set to 2.0 – 2.5 psi and FID Helium to approximately 0.3 psi (the 

needle is just off the stopper “pip.”) 

Check the flow from the “pigtail” at the end of the furnace tube is approximately 1-5ml/min. 

 

To IRMS 

100um silica 

Helium In 

(Water Trap Purge) 

 

Helium Out 

20ml/min 

 
To IRMS 

100um silica 

To Furnace 

220um silica 



 

   Isoprime IRMS-GC-GC5 

Version : 1.13 Page 27 

  

LEAK CHECKING 

Once you are satisfied that all connections are sufficiently tight, carry out a leak check. Initially, a 

hand held leak checker can be used to find major leaks. Following this, check the background argon 

level on the IRMS by tuning for CO2 and then peak jumping to mass 40. This should ultimately read 

less than 5e-12nA on the Minor 1 scale at 200 A trap current. The backgrounds can take some time 

to stabilise. It is recommended to leave the GC overnight for everything to settle. 

It is important that there are no leaks before the system is heated. 

Once the system has been conditioned another leak check will need to be performed. 
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GC CONFIGURATION 

GC5 FURNACE TEMPERATURE 

The combustion furnace and interface can now be switched on via the two switches on the front of 

the GC5. Depending on the type of analysis, the furnace temperature can be set manually. The 

temperatures for each type of analysis are shown in the table below. You can check the current set-

point temperatures by holding the * button for 3 seconds. The temperature can be changed by 

holding the star button and pushing the Up or Down arrows. 

If the unit hasn’t been used for a while there may be a faint aroma. This is normal and will dissipate 

after a few minutes. 

Element Temperature C 

Carbon 850 
Nitrogen 950 
Hydrogen 1000 

Oxygen 1250 

The interface temperature is always set at 350°C 

The GC can now be configured. 

COMMS 

The GC communicates with the IonVantage software via a “Plug and Play” network switch. The GC 

and PC LAN connections connect directly into the switch and then, if available, the laboratory 

network connection can also be connected to the switch for network and internet connectivity. No 

further action is necessary to configure the switch and full internet and network capabilities should 

be available.  

WITH ACTIVE INTERNET CONNECTION 

If the computer is attached to a live network then an IP address or DHCP is assigned automatically to 

the GC. This can be checked via the front panel of the GC. 

Select Options > Communications > Enable DHCP 

Push Yes/Enter and you will then be asked to restart. Select Yes 

Return to the Communications menu and you can view the assigned IP address of the GC. This 

address can then be inputted into the IonVantage software for communication with the GC and no 

further action is required. 
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WITHOUT ACTIVE INTERNET CONNECTION 

If no active internet connection is available then the IP address has to be configured manually. 

On your PC: 

Start > Control Panel > Network Connections 

Right click on Local Area Connection > Properties 

Select Internet Protocol (TCP/IP) and then push the Properties button 

You should see this window 

 

Push the button that says Use the following IP address: 

Input the following: 

IP address 101.1.1.101 
Subnet Mask 255.255.255.0 

Default Gateway Leave Blank 

Leave the DNS server as automatic. 

Now configure the IP address of the GC manually:  

Select Options > Communications 

Manually enter the IP address 101.1.1.100 and Subnet mask 255.255.255.0 and press Enter/Yes. 

Restart the GC. 
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SETUP IONVANTAGE 

Create or open a GC project 

In the Inlet Method window: 

Select the Setup menu > Open > Select installed GC option (e.g. GC7890-Autosampler) 

Select 7890 Menu  

Edit Comms Settings > Enter the GC IP address > OK 

You will now have to restart IonVantage. 

SETUP AGILENT GC 

This manual will now proceed to describe the Agilent 7890 GC settings as standard to Isoprime. All 

these settings are configured using the Agilent front panel. For further information on each of these 

settings please refer to your Agilent 7890 manual. 

CONFIGURATION MENU 

FRONT INLET 

Equilibration Time > 1 

Max Oven Temp > 325 

Detector > Back Detector (Or MSD if installed and required) 

COLUMN 

Push Number 1 

Input the details of the column you are using into this menu. For example, the supplied column from 

Isoprime is: 

Length > 30m 

Diameter > 320um 

Film thickness > 0.25um 
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FRONT PANEL BUTTONS 

OVEN 

Temp > 100 

Initial time > 1 

Ramp > 5 

Final temp 1 > 280 

Time > 60 

COLUMN 

Constant flow 

Flow > 1.2ml 

FRONT INLET 

Temp > 250 

Split > 20 

BACK DET 

Temp > 300 

Flame On.  

This begins the FID start sequence. It will wait until it reaches the set point temperature then 

automatically start the air and hydrogen mix and ignite the flame for the FID. 
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CONDITIONING 

It is recommended after undertaking changes to the physical installation of the GC connections in 

the oven to condition the GC. By heating up the GC oven past its usual operating range, any 

impurities, moisture or residual solvent / sample left in the column can be removed. In essence this 

is similar to a bakeout on a mass spectrometer. 

The oven settings programmed above in the Oven tab are the settings that Isoprime use to condition 

the GC. Under this configuration the oven will sit at 100C for 1 minute before commencing a slow 

ramp at 5°C per min up to 280°C where the oven will then sit for 60 minutes.  

This final oven temperature is naturally sample dependant and 220°C is adequate to the needs of 

the Isoprime Universal Mix, where the oven settings rarely go above 220°C. Should you wish to 

condition at a higher temperature, the maximum oven temperature recommended for a HP5 

column is 325°C. 

By pressing Status on the GC front panel you can receive feedback on what the status of the GC 

oven. Once the GC status is “Ready for Injection” press Start on the GC front panel. As the GC being 

controlled by IonVantage, this action will only start the Oven ramp procedure and nothing else. 

Once the run finishes, whilst the fittings are still hot; proceed to nip up all new connections made in 

the GC oven prior to conditioning. Most connections should need no more than ¼ turn. Some may 

need a little more.  

Be aware that over tightening of the connections when the GC is still hot can cause the threads to 

shear or seize if over tightened.  
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RUNNING AN ANALYSIS 

SETTING UP IONVANTAGE 

This section will describe how to set up IonVantage and the Agilent GC for carbon analysis using the 

supplied standard Agilent 16 position autosampler carousel. 

OPEN AN EXISTING OR CREATE A NEW GC PROJECT 

Create or a new project using the project wizard based on the default GC template. 

To create a new sample list, go to the sample list page and either: 

 Click File > New 

The following New Sample List Window will appear: 

 

 

Several pre-installed sample list templates are available to the user. 

 New Blank Sample List: creates a completely blank sample list and is only advisable to 
be used by expert users. 
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 GC analysis: creates a sample list which has all the necessary settings for a complete 
sample run for the different elements and both for manual as well as autosampler 
injections. 

 

 GC FID analysis: creates a sample list which includes a sample run that sends all the 
GC effluents to the FID detector, used for determination of the operational timings of 
all valves. 

 

 Ref gas stability: creates a sample list which includes all the necessary protocols for 
running reference gas performance tests, such as stability and H3correction factors. 

 

All of these individual list functions can be combined into just the one sample list and for ease of use 

that is how this manual will proceed. 

SAVING THE GC METHOD FILES 

All of the Agilent GC Method programming such as oven ramps, temperatures and flows are done 

via the Agilent front panel. These settings are then manually retrieved by a user and saved from the 

GC into IonVantage as an Inlet file and are called up when running an analysis from the sample list. 

Currently the GC settings should still be set as described in the last chapter (See page 32) the only 

settings that need to be changed for analysis are the Oven temperatures and ramps.  

For testing carbon using the Universal mix the following GC Oven settings are used: 

Temp 100°C 
Initial Time 1 min 

Ramp 1 15°C/min 
Final Temp 200°C 
Final Time 0.7 min 
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The GC starts at 100°C and holds at this temperature for 1 minute. The oven will then ramp at 15°C 

per minute until it reaches 200°C where it will then stay at this temperature for 0.7 minutes. 

This gives a total run time of 8.367 minutes. This time will be needed to set up our IonVantage 

method later. 

Once these temperature settings have been programmed into the GC return to IonVantage and 

resave all the GC Method settings to the software. This is done by going to the Inlet Method 

window. 

On the left hand side of this window click Inlet. 

At the bottom of the window there are 3 buttons as shown below: 

 

 

Click “Get/Save Method from GC” and save this file with a name, for example, CO2 AutoInjection.  

All current GC settings are now saved to an IonVantage Inlet file. Whenever this Inlet file is selected 

in the sample list, IonVantage will automatically load and reprogram the GC with these settings. Any 

number of Inlet method files can be saved for various applications. 

NOTE: If any alterations are made to the GC settings always ensure to Get/Save Method from the GC 

else on running the next analysis any alterations will be overwritten by the selected last saved Inlet 

method. 
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FID RUN 

For optimum column efficiency, the sample should not be too large and should be introduced onto 

the column as a "plug" of vapour. Slow injection of large samples causes peak broadening and loss of 

resolution. The most common injection method is using an autosampler with a micro-syringe. The 

sample is injected into the injection port through a rubber septum into the liner where the sample is 

vapourised. The temperature of the sample port is usually about 50°C higher than the boiling point 

of the least volatile component of the sample. 

The first step when running a new sample is to determine when to open and close the Heart Split 

valve.  

Sending solvent to the furnace strips the oxygen off the furnace tube very quickly and reduces its 

lifespan very quickly as well as shortening the life of the IRMS ion source. By first sending the entire 

sample to the FID, a user can gauge when to open and close the Heart Split valve to initially send the 

solvent to atmosphere and then divert the required sample components to the IRMS for analysis. 

To do this set up the sample list as shown below: 

 

File Name: Give the analysis a file name, i.e. FID Run 01. This is the name that will be given to the 

folder used to save all the data 

MS File: Select the default GC-FID run 

Inlet Method: Select the previously saved GC method i.e. CO2 AutoInjection 

Bottle: Selects the sample bottle position in the Auto Sampler carousel. Make sure to check you 

have the right number set before starting analysis.  

Injector: Can be Front or Back depending on the optional extras that may have been requested. 

Default is Front. 

Inject Volume: The pre-set numbers are a percentage of the needle volume. Set this to 10.0000 for 

the FID run. (Using a 10µl syringe, this will inject 1µl)  

Process: Use the standard IsoprimeDP data processing. 

Once this has been done, FID analysis can be run. The analysis can be viewed in real time by clicking 

on View > Data Display on the left hand side of the IonVantage main window. A completed FID scan 

is shown below in the bottom window in blue. 
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There should be 5 peaks similar to the above. If there aren’t any peaks or these peaks are very small 
please see the Troubleshooting section on page 56. 
 
 

BREAKTHROUGH 

If all connections have been made correctly and all flows set as specified, then all of the sample 

should divert to the FID. If there is a blockage or incorrect helium flow, for example, then some of 

the sample will “breakthrough” into the furnace tube and appear on the IRMS as shown in the top 

window of the scan page. This is undesirable as we want the entire selected sample going to either 

the FID or the IRMS. Please see the 56 for information on how to fix breakthrough. 
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SETTING UP HEART SPLIT TIMINGS 

The first and what should be the broadest peak is the solvent peak, followed by 4 less broad peaks. 

These are the sample peaks. The IonVantage carbon analysis method needs to be edited in order to 

open and close the Heart Split around the 4 sample peaks, diverting these to the IRMS. The solvent is 

also directed away from the furnace and IRMS to the FID. 

This is done my modifying the MS File. In the Sample List window in IonVantage set the file to GC-

CO2 Run from the dropdown box in the MS File column. Right click on GC-CO2 run and open. A 

method window should open similar to the one below. 

 

Note: GC time is in minutes and IRMS in seconds 

This window defines the control method of the IRMS, that is to say when valves open and close, 

what species to measure, what tunings to use and when to take reference gas measurements, 

among many other advanced control parameters which are beyond the scope of this manual. 

In this method there is a reference gas pulse, followed by the Heart Split open and close timings and 

then another reference gas pulse. For the purpose of measuring the Universal Mix, only one 

reference gas pulse is required so the second pulse can be deleted. 

Double clicking on GCHeartSplit will open the command for editing. Looking at the previous FID run 

(shown above) a good time to close the Heart Split valve and divert the rest of the sample to the 

IRMS would be approximately 210 seconds. All of the solvent has now reached the FID and the signal 

is back to baseline. 

When considering the time to open the Heart Split valve, the time it takes for the sample to reach 

the IRMS is longer than the time the sample takes to reach the FID as the sample now must pass 

through the combustion furnace, through the nafion (and/or cryogenic trap if measuring nitrogen) 

and then into the IRMS.  
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Common practice is to add approximately 30 seconds after the last peak has reached the FID.  In this 

case setting the GCHeartSplit - Open to approximately 480 seconds is advised.  

 

NOTE: If the IonVantage method finishes before the GC method the software will stall. Please ensure 

the IonVantage Method is longer than the GC Method by approximately 10 seconds. 

The GC method time from earlier was 8.367 minutes. The GC method time must be slightly shorter 

than the IRMS method. So if the GC method is 8.367 minutes (502 seconds), setting the IRMS 

method to be about 510 seconds should be adequate. 

The End of Acquire “delay” in the IRMS method can be increased or decreased accordingly to fit this 

criteria. In our example the Heart Split opens after 480 seconds and to ensure the IRMS method is 

510 seconds, set the delay to 30 seconds. Our GC CO2 Run method should look like the figure below. 

 

Now the Heart Split timings have been provisionally set, a carbon analysis of the Universal Mix can 

now be performed. Save this method as, for example, GC-CO2 Run and close the window.  

Heart Split Closed Heart Split Open 
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PEFORMING A CARBON ANALYSIS 

The sample list for an analysis is set up as per the FID Run except all files should now reference a CO2 

analysis. 

 

Give the Run a file name, select the previously modified GC-CO2 Run, and select the GC method we 

wish to use (CO2 AutoInjection). An injection volume of 2.000% is adequate. Ensure bottle number 

matches the carousel number in which the sample bottle is placed. 

Select the analysis required to be run in IonVantage and press start. 

A similar chromatogram should be obtained: 

 

The top window shows the IRMS and bottom window the FID. 

The top window contains the Reference Gas peak and the four sample peaks in the Universal Mix 

sample. 

The bottom window shows the solvent peak on the FID. The two little “spikes” are simply the Heart 

Split valve opening/closing and sending a short pulse to the FID.  

REOXIDISING THE CARBON/NITROGEN FURNACE TUBE 

(Carbon/Nitrogen only (CuO)) 
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After continual use of the GC5, the oxygen in the furnace tube is slowly depleted, causing smaller 

and smaller peaks, decreased quality of chromatography, poor results and/or if measuring nitrogen, 

a very large mass 30 background.  

The furnace tube can be regenerating by reoxidising the tubes filling. This involves bleeding oxygen 

into the furnace tube oxidizing either the copper. 

PROCEDURE 

Please refer to the Isoprime User Manual if unsure how to implement some of the more advanced 

IonVantage procedures outlined in this procedure. 

Drop the temperature of the GC5 furnace to 600°C. The regeneration process is more effective at 

this temperature. 

Tune for Mass 33 by peak jumping from a N2 tuning. By peak jumping to mass 33 this puts mass 33 in 

the Axial bucket or Minor 1 and thus mass 32 is now in the Low Mass bucket or Major, which has a 

lower gain and so we can observe bigger beams than in the Minor 1 bucket. 

Open the O2 flush valve on the Inlet Method page of IonVantage. The O2 flush valve on the GC5 

should already have been set to give a max beam size of approximately 10 – 12 nA of oxygen. If not 

then the oxidization process will need to be monitored to ensure that the tube and IRMS isn’t 

flooded with oxygen. 

Start a 3600 second time scan and monitor the O2 level on the Major scale. Initially, the level of 

oxygen in the system will decrease as the tube absorbs the oxygen. As the tube becomes more 

oxidized the amount of absorption decreases and the level oxygen in the system will start to 

increase. Once the level oxygen stabilizes (this should be at about 10-12nA) then the tube is no 

longer absorbing oxygen and is fully oxidized, hence fully regenerated.  

If the tube takes longer than 3600 seconds to regenerate simple start another, longer time scan and 

continue to monitor the rise. 

If the oxygen level continues to climb past 12nA wind in the oxygen flush valve on the side of the 

GC5 until stable 10-12nA oxygen level is observed.  

Note: The response time of the O2 flush valve is much slower than that of the Reference Gas Box 

due to the extra length of tubing and silica capillary it must travel through to reach the IRMS. 

Please allow at least 30 seconds before troubleshooting any potential problem 
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GC5 OPTIONAL UPGRADES  
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NITROGEN ANALYSIS 

Nitrogen analysis is carried out by using a cryogenic or “cold” trap. This consists of an insulated 

dewar flask filled with liquid Nitrogen, into which a piece of 320µm deactivated silica is submerged 

into the liquid nitrogen. This has the effect of freezing both H2O, CO2and CO (arising from CO2 

combustion) to allow for accurate N2 measurements. The system has no electronic temperature 

control and relies entirely on the liquid nitrogen temperature (≈ -196 °C) to capture both the H2O, 

CO and CO2. 

SET UP FOR N2 ANALYSIS 

Note: Before making any changes to the physical connections on the instrument, remember to close 

the Nupro valve on the Isoprime (or divert to waste if a Standby valve is installed). This will prevent 

air reaching the system and prolong the lifetime of the filament, keep the instrument clean and 

enable the instrument to stabilise much quicker. 

In the default Isoprime configuration no changes need to be made to the GC5 combustion tube as 

Carbon and Nitrogen analysis is performed using the same tube.  

The cold trap assembly is set up as shown below: 

 



 

   Isoprime IRMS-GC-GC5 

Version : 1.13 Page 44 

The cold trap should be set up so that the two loops of the deactivated silica should be as low down 

in the dewar as possible so fewer refills are required. 

The assembled cold trap is then added in series in between the end of the combustion tube and the 

Isoprime as shown below: 

 

The nafion is not required for N2 analysis and should be disconnected from the system. No 

conditioning of the trap is necessary. 

Note: If constant switching between Nitrogen and Carbon analysis is required, having to change 

system configuration constantly can be a long process. The system can be run with the nafion and 

cold trap all connected together in series (without filling the trap with liquid nitrogen for Carbon 

analysis) however you may lose some sensitivity and chromatography by doing so. To run in this 

configuration simply disconnect the piece of silica going to the IRMS from the nafion and connect it 

to the cold trap in place of the 100µm silica as shown in the diagram above. 

As ever, results of running in this configuration are application specific so it is advisable to set up the 

system with a configuration that works best for the user’s requirements.  
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PERFORMING A NITROGEN ANALYSIS 

When analysing the Universal mix, due to the smaller Nitrogen component in the mix compared to 

Carbon, a smaller inlet split ratio and a higher injection volume are advised to obtain good sensitivity 

and chromatography. Recommended values are a 10:1 split ratio set on the GC and 10.000% 

injection volume requested in IonVantage. After making these changes save the altered GC method 

(via the “Get/Save from GC” button in the Inlet Method window) as ‘N2 AutoInjection,’ for example.  

As a result of incorporating the extra silica by the introduction of the cold trap to the system, the 

transport time for the sample entering the Isoprime will now be slightly longer. You may wish to run 

another FID analysis to determine new Heart Split timings as detailed in page 38. The IonVantage 

GC-N2 method file will need to be modified to take into account the new Heart split timings. 

Once the Heart Split timings have been established, you may also need to increase your GC oven 

temperatures to factor in the longer analysis time. This is best achieved by increasing the final 

temperature of the GC oven. (See page 31 and 38  for further information) 

Save any changes made to the GC method in IonVantage. 

The sample list for Nitrogen analysis should be similar to the one shown below: 

 

Select the analysis required to be run in IonVantage and press start. 

A chromatogram similar to the one below should be obtained: 
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There should only be one large peak compared to the 4 peaks as seen in the Carbon analysis. This is 

the Nitrogen containing component of the Universal mix. All other carbon containing compounds 

will have been frozen in the cold trap.  

If you see all 4 peaks please check that the cold trap contains enough liquid nitrogen. 
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HYDROGEN ANALYSIS 

Analysing hydrogen requires a separate combustion tube to be installed. The tube is filled with 

chromium oxide instead of copper oxide used for carbon and nitrogen analysis. The tube needs to be 

filled manually and the amount and position of the filling should be identical to the copper oxide 

combustion tube. 

SETTING UP FOR HYDROGEN ANALYSIS 

When removing or changing the tube the GC5 furnace and interface should be left to cool to a safe, 

comfortable temperature (room temperature recommended) for the user to be able to handle the 

tube. To cool, simply turn off the green switches on the front of the GC5 furnace. 

Note: Fingerprints on the tubes should be avoided so gloves should be worn at all times when 

handling the tube. 

The installation of a tube should be performed as described on page 21. 

Note: The nafion is not required for analysis but the system can be run with the nafion connected, 

however you may lose some sensitivity and chromatography by doing so. To run in this configuration 

simply connect the nafion as described for setting up for a carbon analysis (page 26) 

As ever, results of running in this configuration are application specific so it is advisable to set up the 

system with a configuration that works best for the user’s requirements.  

When analysing hydrogen, the GC5 furnace is operated at 1000°C. The interface temperature is 

operated at 350°C 

Once the tube has been installed it will need to be conditioned by heating the tube to operational 

temperature and leaving for approximately 6 hours. 

PERFORMING A HYDROGEN ANALYSIS  

Running a hydrogen analysis is very similar to running a carbon analysis (see page 40) 

When analysing the Universal mix, due to the smaller hydrogen component in the mix compared to 

carbon, a smaller inlet split ratio and a higher injection volume are advised to obtain good sensitivity 

and chromatography. Recommended values are a 3:1 split ratio set on the GC and 10.000% injection 

volume requested in IonVantage. After making these changes save the altered GC method (via the 

“Get/Save from GC” button in the Inlet Method window) as ‘H2 AutoInjection,’ for example. 

You may wish to run another FID analysis to check the Heart Split timings as detailed in page 38. The 

IonVantage GC-H2 method file will need to be modified to take into account any changes needed to 

Heart split timings. 
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Set up the sample list as shown below and run the analysis. 

 

You should obtain a chromatogram similar to the one shown below. There will be a small rise in the 

baseline during the analysis. This is normal behaviour when analysing GC hydrogen: 
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OXYGEN ANALYSIS 

 
Oxygen analysis is performed using a nickel tube enclosed within a ceramic outer tube. Hydrogen is 

used to provide a clean, dry reducing atmosphere to provide optimum conditions for pyrolysis of the 

sample. The oxygen component of carbon monoxide is used as the reference gas for analysis. 

SETTING UP FOR OXYGEN ANALYSIS 

 
Turn off the interface, furnace and GC oven and close the Nupro valve on the IRMS. After the system 

has cooled, turn the sample line and FID helium to zero. 

 

Remove any previously used furnace tubes from the GC. 

PREPARATION OF THE GC O TUBE 

 
The GC oxygen tube consists of a nickel tube placed inside a 6mm ceramic tube, as shown below: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note: The nickel tube must be 15mm longer than the outer ceramic tube so that the inner GC 
connections can be made. 

 
 
 
 
 
 
 
 
  

615mm Nickel 
tube  

 

600mm Ceramic Tube.  
6mm OD, 4mm ID 
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GC OVEN CONNECTIONS 

 
The connections to be made inside the GC oven are shown below: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
It is important to seal the nickel tube in the correct position using the sealing ring inside the T-piece. 

If the nickel tube is not pushed further enough through the sealing ring, then the flow of the sample 

line hydrogen/helium gas can be interrupted and/or oxygen could leak into the nickel tube, 

preventing complete pyrolysis. 

 

It is also important to note that a different connection for the sample line helium/hydrogen mix is 

required. This is an additional piece of stainless steel tubing that is connected to the hydrogen line in 

the GC5 and allows a supply of hydrogen for oxygen pyrolysis. 

 

The 250µm fused silica has the polyimide coating removed for the first 20mm inside the furnace 

tube. Insert the fused silica no more than 50mm into the nickel tube. 

FURNACE GC CONNECTIONS 

 
The GC outer connections are as shown below: 
 
 

 

 

250µm Silica 

Nickel 
Inner Tube Silica 20mm 

Polyimide 
Coating 

removed 

Sample Line He/H2 mix 

VSR 16-16 
sealing ring 

Ceramic 
Outer Tube 

Ceramic Outer 
Tube 

Vent 1-5 ml/min 

To Isoprime 

Nickel Inner Tube 

100mm Silica Inside 
Nickel Tube 
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The fused silica is to be inserted no more than 100mm inside the nickel tube. Due to the high 
operating temperature the fused silica can easily become too hot and melt blocking the He flow to 
the Isoprime. 
 

CONDITIONING THE FURNACE 

 
Once all connections have been made, ensure the whitey selector valve situated on the front of the 

GC interface is set to LEFT and connect a supply of hydrogen (the minimum grade to be used is 

specified in the site requirements document) to the rear of the GC5. Set the flow via the hydrogen 

pigtail vent situated to the left hand side of the GC5 to ≈ 5ml/min. 

 

Set the sample line pressure to 2psi and the FID helium flow to 0.3psi. Check the flow out from the 

outer connection pigtail. This should be read approximately 1 - 5ml/min. 

 

The GC column will need to be conditioned. See page 32 for information on conditioning the column.  

 

Leave the system overnight to allow all background levels to settle then leak check the system using 

argon (see page 27), paying particular attention to the GC oven fittings.  

 

When satisfied the system is leak tight set the furnace temperature to 1250°C and the interface 

temperature to 350°C. It is important to isolate the Isoprime during heating either by the use of a 

standby valve or closing the Nupro isolation valve on the Isoprime to avoid contamination.  

 

CHECKING BACKGROUND LEVELS 

 
With the trap current set at 600µA and the IRMS tuned for mass 28 (CO), run a magnet scan and 

ensure that the background levels are as shown in the table below: 

 

Species Mass Beam (nA) 

Water 18 <1e-9 
Nitrogen 28 <5e-10 
Oxygen 32 <1e-10 
Argon 40 <5e-12 

Carbon Dioxide 44 <5e-11 

 
If the above backgrounds cannot be achieved, leak check the system once more (using argon 

preferably) and slowly tighten any loose fittings in the GC5 (be careful not to over-tighten these 

though)  

 

It is possible that the backgrounds may still be dropping, albeit slowly and are still currently slightly 

outside of the above expected values. If this is suspected to be the case, set up a time scan for 60 

minutes and monitor the mass. If the background is still falling and hasn’t stabilised continue to 

leave the system until it has settled.  
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If the background has reached its lowest level and is still outside of specification, the furnace will 

have to be cooled down and the furnace tube connections remade.  

 

Check the IRMS backgrounds with the GC heart split valve both open and closed. It is very important 

to have a leak free system before and analysis can proceed. When the system is first setup it will 

take approximately 24 hours for the background to reach its lowest level.  

 

When all the above requirements are reached the system is ready to begin analysis.  
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SETTING UP THE GC 

 
On the Inlet Method window in IonVantage, open the H2 flush valve to add a stream of hydrogen 

into the sample line helium. The H2 flush valve must remain open during any GC oxygen analysis. 

This will provide the reducing atmosphere inside the furnace tube and enable optimum oxygen 

pyrolysis. 

GC INLET METHOD 

 
Set the GC method parameters as shown below (see page 30 for further information) 
 

Parameter Setting 

Split Ratio 20:1 
Injector Temp 260 C 
FID  300 C 
Oven Initial Temp 100 C 
Time 1 1 min 
Rate 1 15 C/min 
Oven Final Temp 1 200 C/min 
Final Time 1 2 min 
Column Flow 1.5 ml/min 

 
Save the new GC method (via the “Get/Save from GC” button in the Inlet Method window) as ‘O2 

AutoInjection,’ for example. When saving the GC method to IonVantage, ensure that the H2 flush 

valve is open. 

 

PRE-ANALYSIS 

 
Before oxygen analysis can be carried out, it is necessary to have a layer of carbon on the inside of 

the nickel furnace tube. This can be achieved by running solvent (such as the hexane solvent used in 

the Universal mix) through the nickel tube. Running a number of these injections will slowly build up 

a significant carbon source inside the nickel tube causing the carbon molecules in a sample to break 

their bonds from the oxygen molecule, leaving just the oxygen component to be analysed. 

  

For the first few injections it is extremely important to have the Nupro valve on the Isoprime closed 

so the large amount of solvent injected through the system doesn’t contaminate the IRMS. When 

carbon is first laid onto the tube, the background will become very high. This should slowly fall over 

a number of hours. As more carbon is laid onto the tube, this effect will be less evident. When the 

tube is ready for analysis the injected solvent will create a small peak that will quickly return to the 

base background level. 
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COATING THE TUBE 

 

The initial laying of carbon in the tube should be done manually. Remove the autosampler if installed 

and set up the GC method as described above. Press start on the front of the Agilent GC panel. This 

will start the GC method. IonVantage need not be used at this point.  

 

Begin to manually inject approx 2µl of the Universal mix (or other suitable solvent) into the system 

approximately every 2 minutes. This will start to coat the inside of the nickel tube with carbon 

contained in the solvent. 

 

Note: Be careful not to inject too much, too fast as there is a risk of blocking the tube with too much 

carbon. 

 

Perform 10 – 15 injections of the solvent before opening the Nupro valve and opening the GC to the 

IRMS. 

 

Begin another manual run on the GC but this time only inject a tiny amount of solvent, < 0.1µl if 

possible. Monitor the solvent peak on the Isoprime using a time scan on mass 28 (CO) If the nickel 

tube has enough carbon coated on it then this solvent peak shouldn’t saturate the collector or trip 

the source. If this is the case keep injecting small amounts of solvent until the size of the solvent 

peak continues to decrease. 

 

If the collector does saturate and/or the source trips, close the isolation valve and repeat the 2µl 

injections 10 - 15 times and then repeat the above steps again. This may take some time but the 

solvent peak size will eventually start to diminish. 

 

Monitoring the solvent peak and the 2 alkane peaks in the Universal mix will give a good indication 

of when the system is ready for analysis. These 3 peaks should become smaller and eventually 

become insignificant when there is enough carbon in the tube. When only the methyl ester and the 

nicotine peak can be seen the system is ready for analysis. 
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PERFORMING AN OXYGEN ANALYSIS 

 
Oxygen analysis is done using a 600µA trap current, so it may frugal to retune the source before 

commencing analysis. 

 

If removed, replace the autosampler now. Modify or create an IonVantage oxygen analysis method 

using the timings gathered from the pre-analysis conditioning run and set up a sample list similar to 

the one shown below. See page 34 for further details on creating methods: 

 

 
 
Run the analysis. You should obtain a chromatogram similar to the one shown below:  
 

 
 

Note: The first peak after the reference peak is all the solvent from the Universal mix going to the 

IRMS. This gives an indication of the level of carbon that should be lay onto the nickel tube before 

accurate oxygen analysis can be performed. The largest peak is the oxygen containing methyl ester 

compound and the last peak is nicotine, seen here due to the instrument looking at mass 28. 
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TROUBLESHOOTING 

 

Very small or No peaks on FID 

Is FID flame ON  

Is Injection port liner blocked 
See Agilent manual for further 

details on maintenance 
Remake connection 

Is FID blocked 
See Agilent manual for further 

details on maintenance 

Is silica blocked or crushed Cut and remake connection 

Check silica in VSOS connection 
is not crushed or blocked 

Remake connection taking 
extra care 

Is  syringe plunger attached to 
autosampler via thumbscrew 

Check autosampler 

Check syringe is not damaged 
or blocked 

Change syringe 

Check sample quantity and 
syringe reaches sample 

 

Check Adequate Injection 
Volume 

In IonVantage check Inject 
Volume column is set correctly 

 

  

Very Small or No Peaks on 
IRMS 

 

Run through No Peaks on FID 
section above 

 

Is furnace tube blocked 
Cool down furnace, remove 

tube and check for breakages, 
blockages and/or broken silica 

Is Nafion tube broken or 
blocked 

Remake Nafion assembly 

Check IRMS inlet connection 
Check and remake IRMS inlet 
connections i.e. ferrules and 

silica 

Check sample line Helium flow Set to 2.0 – 2.5 psi 

Is stripped silica correctly 
inserted into furnace tube 

 

See also Isoprime 
troubleshooting guide 
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FID won’t ignite 

Does supplied flow match 
requested flow 

Check gas supply/quantity of 
gas 

Is FID blocked 

Remove blockages from top of 
FID 

See Agilent manual for further 
details on maintenance 

Check FID ignition 
See Agilent manual for further 

details on maintenance 

Increase or decrease hydrogen 
and Air flows. 

Repeat with some trial and 
error 

Leave gases purging through 
FID for 1hr and try again 

 

 

Breakthrough to IRMS 

Is FID Helium pressure to high Reduce to 0.3psi 

Check blockages and crushed 
silica 

Cut and remake silica 
connections 

Is Heart Split Valve closing (See 
also Heart SplitSection) 

Place silica from bottom of 
Heart Split in Acetone or 

similar. When Heart Split is 
closed no bubbles should be 

observed 

 

Heart Split Valve Heart Split doesn’t open/close 

Check compressed air and hiss 
when opening/closing 

Place silica from bottom of 
Heart Split in Acetone or 

similar. When Heart Split is 
closed no bubbles should be 

observed 

Change and remake ferrule and 
silica fitting 

Check ferrule sits flush inside 
Heart Split 

Change Heart Split Assembly 
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IonVantage Issues 

For any error messages and/or 
non-ready status’s 

If you have a Multimode 
Injector (MMI) and/or 

CombiPal system installed 
please ensure latest version of 

IonVantage is 1.5.4 for full 
compatibility 

No Communication 

Check IP address in IonVanatge 
is the same as IP address set on 

the GC.  
 

IP address of PC must be 
different. 

Check network switch is turned 
on and all network cables are 

connected 

 


